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SECTION 1: PRELIMINARY INFORMATION

1.1 Warranty Information

This unit is warranted by LMI against defects in materials and workmanship for one year from the date of original purchase. If you transfer ownership, the warranty is auto-
matically transferred to the new owner and remains in effect for the remainder of the first year after the date of original purchase. During the warranty period, LMI will repair,
or at our option, replace at no charge, product that proves to be defective, provided it is returned with shipping prepaid to LMI.

This warranty does not apply if the product has been damaged by accident or misuse or as a result of service or modification by any party other than LMI, or by hardware, soft-
ware, interfacing, or peripherals not provided by LMI.

Please retain this document for your records. No other express warranty is given. The repair or replacement of a product if your exclusive remedy. Any implied warranty of
merchantability or fitness is limited to the one year duration of this written warranty. Some states do not all the exclusion or limitations of incidental or consequential damag-
es, so the above exclusion or limitations may not apply to you based on location.

1.2 LM Customer Service

LMI Customer Service can be reached at +1 (810) 714-5811 Monday through Friday between 8:00 am and 5:00 pm Eastern Standard Time.
Call LMI Customer Service to:

| = Place orders
= Return LMI equipment for service
= Inquire about the status of an order or repair

1.3 Returns for Service

Contact Customer Service for a Return Material Authorization (RMA) number. Please include a detailed description of the problem.

Pact the equipment properly. Use the original shipping container if possible. LMI cannot assume responsibility for damage cause by improper packaging.
Send the equipment with RMA to:

LMI Corporation
ATTN: Repair Department
101 N. Alloy Drive
Fenton, M1 48430
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1.4 LM Technical Support

LMI Technical Support experts are only a phone call away. Contact Technical Support at +1 (810) 714-5811 Monday through Friday be-
tween 8:00 am and 5:00 pm Eastern Standard Time. Technical Support can:

= Assist in setup and configuration of LMI equipment and software

= Help implement data collection applications

= Troubleshoot LMI equipment and software
Technical Support can also be reached by email at techsupport@Imicorporation.com. Please include your name, phone number, and a

detailed description of the problem.

LMI On-site Training

LMI Technical Support also provides on-site training for all LMI products. Contact LMI Customer Support at +1 (810) 714-5811 for pricing and scheduling information. Schedule
a day at your facility or at LMI headquarters in beautiful Fenton, Michigan.

LMI Website

LMI has a large repository of online technical support documentation located at www.Imicorporation.com/techsupport. Here you can find instructional videos, product manu-

als, and application-specific documents for all LMI products.
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SECTION 2: GAUGE OVERVIEW AND FUNCTIONS

All LMI wireless gauges except for the G-WHIZ have a simple user interface consisting of one button, one bi-color LED, and one internal speaker. The LMI G-WHIZ velocity clo-
sure gauge has three buttons and a bi-color LED.

BUTTON:

- Press and release the button to send a reading to the PC via a wireless signal.

- Hold the button down for four seconds to place the gauge in SETUP mode.

- Hold the button down again for four seconds to exit SETUP mode.

- Note: the PRESS and HOLD functions on all LMI SealGap gauges is reversed. SealGap gauges have this functionality reversed to behave like other LMI gauges.

LED:

-If the gauge is associated to the base, the gauge will respond with a beep and the LED will flash green one time. If the gauge is not associated or is not picked up by the
base, the LED will flash red and “chirp” five times to indicate the signal was not sent.

-The LED is also used to indicate when the gauge is in SETUP mode. In this mode, the LED will continually flash green. SETUP mode enables the user to change certain
gauge parameters via PC commands to to request readings. SETUP mode is covered in more detail in SECTION 4 of this manual.

BUZZER:

- In addition to visual indication from the LED, each wireless gauge also contains a small audio buzzer which can be turned off and on through the LMI Wireless Utility.
- Even if the audio is turned off, the gauge will still beep if (a.) the base does not receive the signal from the gauge and (b.) when the battery is low.

MASTERING:

- All LMI Wireless gauges are calibration before shipping from LMI. Calibration is stored in the microprocessor of the gauge and will not be lost if the batteries are removed
or replaced.

- LMI Wireless gauges can be mastering as often as deemed necessary or when your company’s internal quality department requires.

- All LMI Wireless gauges except for the Diamondback Wireless Digital Indicator are mastered in the LMI Wireless Utility software.
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BATTERY LIFE:

- The LMI 200W (type CR2) and Diamondback (type AA) have non-rechargeable batteries that will typically transmit 250,000 readings before requiring new batteries. All 2.4
Ghz rechargeable models will run for eight hours of continuous readings (four per second) before needing a recharge.

- All wireless gauges except the Diamondback Wireless and G-WHIZ will make a distinctive chirping sound (three consecutive beeps with a different tone for each beep)
when the battery needs replacing or recharging.

- Rechargeable models should be connected to an in-line charger or placed in their recharging cradles when not in use.

- Li-ion batteries last longer when kept charged.

Wireless Single Gauge In-Line Charger

The LMI Single In-Line charger is designed to charge one LMI wireless gauge at a time. The charger uses a single-cell Li-ion smart charging
circuit to guarantee correct charging levels and safety.

Plug the round connector into the LMI Wireless Gauge and plug the power pack into a standard 120V outlet. The LED on the charger will
glow red when the unit is charging, and turn green when fully charged

LMI Charging Cradle

The LMI Charging Cradle is capable of charging up to four Wireless Seal Gap gauges at a time. The cradle uses a
single —cell Li-ion smart charging circuit to guarantee correct charge levels and safety.

Place the Wireless Seal Gap gauges into the cradle—connector side down— until they “click” into position. The
LEDs will glow red when the gauges are charging, and turn green when fully charged.

Should your gauge(s) become too discharged (possibly due to leaving them out of the cradle over the weekend),
the Charging Cradle LED will not illuminate when the unit is first plugged in. This is a precharge, low-current state.
After a few minutes the LED will glow red and normal charging will continue. A fully discharged battery will
around 2-3 hours to recharge.

WARNING: Using any other charger not supplied by LMI may cause damage to the gauge and void all warranties.
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Section 3: Wireless Gauge Specifics

3.1 LMI 200W Wireless Probe Transducer

p T —

Using the LMI 200W Wireless Probe Transducer

To change the battery, remove the single pan-head screw on the side of the probe and slide the door down,
away from the probe in the direction the arrow indicates.

The LMI 200W is powered by a lithium CR2 battery, which will transmit around 250,000 readings before a new battery is required. If a
low battery situation is present, the probe will emit a distinctive beeping sound to alert the user of the need to replace the battery.

The 200W must be associated with a wireless base unit through the LMI Wireless Utility software (see section 4) before use. The probe is calibrated before leaving the factory
and does NOT require mastering on a daily basis. The calibration is stored within the microprocessor of the probe, which eliminates the need for repeated mastering. Master

can be performed as often as a company’s quality policy dictates, and is a simple three step process using the LMI Wireless Utility.

Sending Data to the PC

The 200W includes a Bi-colored LED, data transmit button, and internal speaker for use use and verification that data is collected when requested. To send data to the soft-

ware, press and release the button on the top of the probe. The LED on the probe will flash green to indicate the reading was sent. If the reading is not received, the probe will

beep five times and the LED will flash red five times. If this occurs, verify the following:

¢ Verify the base is connected to the PC via a USB port on the PC.

¢ Verify the probe is associated to the base.

¢ Verify the probe is not in a “low power” state.

Probe Behavior in Setup Mode

Operation

Button Action

LED Status

Results/Status

Enter setup mode

Press and hold the button for four sec-
onds

LED continually flashes green when in
setup mode

Probe is in setup mode to calibrate or
change probe operation

Send information when in setup mode

Press and release

LED continually flashes green when in
setup mode

Information is sent to the software

Exit setup mode

Press and hold the button for four sec-

onds

LED continually flashes red for four sec-
onds

Probe is now ready to collect data
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3.2 LMI 241W Wireless Flush and Gap Gauge

The 241W, 241W-B, and 241W-BW utilize a rechargeable lithium-ion battery that will last approximately eight hours between charging.

The 241W must be associated with a wireless base unit through the LMI Wireless Utility software (see section 4) before use. The gauge
is calibrated before leaving the factory and does NOT require mastering on a daily basis. The calibration is stored within the micropro-
cessor of the gauge, which eliminates the need for repeated mastering. Master can be performed as often as a company’s quality policy
dictates, and is a simple three step process using the LMI Wireless Utility.

Sending Data to the PC

The 241W includes a Bi-colored LED, data transmit button, and internal speaker for use and verification that data is collected when re-
qguested. To send data to the software, press and release the button on the top of the probe. The LED on the probe will flash green to
indicate the reading was sent. If the reading is not received, the probe will beep five times and the LED will flash red five times. If this occurs, verify the following:

¢ Verify the base is connected to the PC via a USB port on the PC.
¢ Verify the probe is associated to the base.
¢ Verify the probe is not in a “low power” state.

Probe Behavior in Setup Mode

Operation

Button Action

LED Status

Results/Status

Enter setup mode

Press and hold the button for four sec-
onds

LED continually flashes green when in
setup mode

Probe is in setup mode to calibrate or
change probe operation

Send information when in setup mode

Press and release

LED continually flashes green when in
setup mode

Information is sent to the software

Exit setup mode

Press and hold the button for four sec-
onds

LED continually flashes red for four sec-
onds

Probe is now ready to collect data
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3.3TP 107W and 108W

The TP 107W and TP108W utilize a rechargeable lithium-ion battery that will last approximately eight hours between charging.

The probe must be associated with a wireless base unit through the LMI Wireless Utility software (see section 4) before use. The gauge is cali-
brated before leaving the factory and does NOT require mastering on a daily basis. The calibration is stored within the microprocessor of the
gauge, which eliminates the need for repeated mastering. Master can be performed as often as a company’s quality policy dictates, and is a
simple three step process using the LMI Wireless Utility.

Sending Data to the PC

The TP Wireless probe includes a Bi-colored LED, data transmit button, and internal speaker for use and verification that data is collected

when requested. To send data to the software, press and release the button on the top of the probe. The LED on the probe will flash green to
indicate the reading was sent. If the reading is not received, the probe will beep five times and the LED will flash red five times. If this occurs, verify the following:

¢ Verify the base is connected to the PC via a USB port on the PC.
¢ Verify the probe is associated to the base.
¢ Verify the probe is not in a “low power” state.

Probe Behavior in Setup Mode

Button Action

Operation

LED Status

Results/Status

Enter setup mode

Press and hold the button for four sec-
onds

LED continually flashes green when in
setup mode

Probe is in setup mode to calibrate or
change probe operation

Send information when in setup mode

Press and release

LED continually flashes green when in
setup mode

Information is sent to the software

Exit setup mode

Press and hold the button for four sec-
onds

LED continually flashes red for four sec-
onds

Probe is now ready to collect data
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3.4 Wireless Diamondback Digital Indicator

Sending Data to the PC

¢ Verify the base is connected to the PC via a USB port on the PC.
¢ Verify the Diamondback is associated to the USB Base.

Indicator Behavior in Setup Mode

The Wireless Diamondback digital indicator operates on two AAA batteries that will last up to 500,000 transmissions.

The Wireless Diamondback must be associated with a wireless base unit through the LMI Wireless Utility software (see section 4) before use. As
the Wireless Diamondback is a digital indicator, it does not have to be mastered, but can be re-zeroed as often as a company’s quality policy dic-
tates. Please refer to the Diamond Digital Indicator manual for additional information.

The LMI Wireless Diamondback includes an orientation button, data transmit button, and display for use and verification that data is collected
when requested. To send data to the software, press and release the blue SEND DATA button. The LEDs on the bases will flash green to indicate
the reading was sent. If the reading is not received, the indicator will display “rF Err.” If this occurs, verify the following:

Operation

Button Action

LCD Status

Results/Status

Enter setup mode

Press and hold the in/mm button for four
seconds

LCD displays two triangle icons continual-
ly flashing in sequence when in setup
mode

Probe is in setup mode to associate to a
USB base

Send information when in setup mode

Press and release the in/mm button

The word “Data” will flash briefly on the
LCD

Information is sent to the software

Exit setup mode

Press and hold the in/mm button for four
seconds

LCD displays reading , both triangles on
the CD will disappear

Probe is now ready to collect data

LMI Wireless Utility Manual 11



3.5 Wireless Seal Gap Gauges

Wireless Seal Gap gauges utilize an internal rechargeable lithium-ion battery that will last approximately eight hours between charging.

The gauges must be associated with a wireless base unit through the LMI Wireless Utility software (see section 4) before use. The gauge is cali-
brated before leaving the factory and does NOT require mastering on a daily basis. The calibration is stored within the microprocessor of the
gauge, which eliminates the need for repeated mastering. Mastering can be performed as often as a company’s quality policy dictates, and is a
simple three step process using the LMI Wireless Utility.

Sending Data to the PC

The LMI Wireless devices include a bi-color LED, a Button to configure the Wireless Seal Gap Gauge, and an internal buzzer for easy use and
verification that data is collected when requested. The Wireless Seal Gap Gauges are defaulted so that the software will request a reading
when required. A single “beep” can be heard when data is transmitted.

If you hear 5 “Beeps” and witness the red LED flash 5 times, the data was not transmitted to the wireless base unit.

- If this condition is present, verify the following:
- Verify the Wireless Base Unit is connected to Com Port on PC and powered.
- Verify gauge is still “associated” with the Base Unit (reference section 4.3)
- Verify the gauge is not in a “Low Power” state.

Set-Up Mode Operation

The buttons and LED status is also used to put the gauge into “Set-Up” mode when configuring and calibrating the gauge within the LMI Utility. The LMI Wireless Seal
Gape Gauge should only be placed into the “Set-Up” mode when using the Utility. Data can only be sent to the software when gauge is out of “Set-Up” mode.

Operation to be .
P Button Action LED Status Buzzer Response Results/Status
Performed
Flash constant green .. . .
Enter set-up mode Press & release . & No change Gauge is in set-up mode to calibrate or change gauge operation
when in set-up mode
Send info when in set- . .
up mode Press & release Flash constant green Beeps one time Info/Date is sent to software
. Flash constant red for 4 . .
Exit set-up mode Press release seconds Beeps one time Gauge is ready to collect data
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3.6 Wireless Dual Seal Gap Gauges

Wireless Seal Gap gauges utilize an internal rechargeable lithium-ion battery that will last approximately eight between charging.

The gauges must be associated with a wireless base unit through the LMI Wireless Utility software (see section 4) before use. The gauge is cali-
brated before leaving the factory and does NOT require mastering on a daily basis. The calibration is stored within the microprocessor of the
gauge, which eliminates the need for repeated mastering. Master can be performed as often as a company’s quality policy dictates, and is a
simple three step process using the LMI Wireless Utility.

.
"| Sending Data to the PC

| The LMI Wireless devices include a bi-color LED, a Button to configure the Wireless Seal Gap Gauge, and an internal buzzer for easy use and
verification that data is collected when requested. The Wireless Seal Gap Gauges are defaulted so that the software will request a reading
when required. A single “beep” can be heard when data is transmitted.

If you hear 5 “Beeps” and witness the red LED flash 5 times, the data was not transmitted to the wireless base unit.

- If this condition is present, verify the following:
- Verify the Wireless Base Unit is connected to Com Port on PC and powered.
- Verify gauge is still “associated” with the Base Unit (reference section 4.3)
- Verify the gauge is not in a “Low Power” state.

Set-Up Mode Operation

The buttons and LED status is also used to put the gauge into “Set-Up” mode when configuring and calibrating the gauge within the LMI Utility. The LMI Wireless Seal
Gape Gauge should only be placed into the “Set-Up” mode when using the Utility. Data can only be sent to the software when gauge is out of “Set-Up” mode.

Operation to be .
P Button Action LED Status Buzzer Response Results/Status
Performed
Flash constant green .. . .
Enter set-up mode Press & release . & No change Gauge is in set-up mode to calibrate or change gauge operation
when in set-up mode
Send info when in set- . .
up mode Press & release Flash constant green Beeps one time Info/Date is sent to software
. Flash constant red for 4 . .
Exit set-up mode Press release seconds Beeps one time Gauge is ready to collect data
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3.7 G-WHIZ Closure Velocity Gauge

The LMI G-WHIZ Door Closure Velocity Gauge utilizes an internal rechargeable lithium-ion battery that will last approximately eight hours be-
tween charging.

The gauges must be associated with a wireless base unit through the LMI Wireless Utility software before use. The gauge is calibrated before
leaving the factory and does NOT require mastering on a daily basis. The calibration is stored within the microprocessor of the gauge, which
eliminates the need for repeated mastering. Calibration can be verified through an “All Axes” check by holding down the Up arrow for three
seconds and then pressing and releasing the center button. For more information on this and other setup features of the G-WHIZ, please refer-
ence the G-WHIZ manual (CA 183) that shipped with the Gauge.

Sending Data to the PC

The LMI G-WHIZ includes a bi-color LED and three buttons to navigate the menus of the device. The G-WHIZ is attached directly to the vehicle door through an industrial-
strength suction cup before the measurement begins. The operator opens the door of the vehicle, presses the center button and waits for the green LED to activate. At this

point, the operator closes the door to complete the test. The operator then has the choice to restart the test using the Down arrow or send the test results by pushing the Up
arrow.

Operation to be

Button Action LED Status Results/Status
Performed
Press and hold center button until LED turns off User has the ability to use the up and down arrow
Change Model then press and release the down arrow. Once in Flash constant green buttons to select one of ten models stored within the C-
the menu, press the center button to select SETUP when in set-up mode WHIZ. Press the center button to select the model and
MODE exit setup mode
Press and hold center button until LED turns off
Enter set-up mode then press and release the down arrow. Once in Flash constant green Gauge is in set-up mode to calibrate or change gauge
the menu, press down arrow once and then center when in set-up mode operation

button to select SETUP MODE

Send info when in set-

up mode Press and release center button Flash constant green Info/Date is sent to software

Green flashing LED be-

Exit set-up mode Press and hold center button
comes red

Gauge is ready to collect data
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SECTION 4: Wireless Utility Software Overview, System Requirements, and Installation

4.1 Software Overview and System Requirements

The LMI Wireless Utility software allows the user to associate, calibrate, and configure all LMI wireless gauges.*

System Requirements

Minimum Computer Specifications:
Operating System: Windows 7 (32 Bit/64 Bit)
Screen Resolution: 1024x768
Memory: 4 GB
Processor Speed needed: Intel i3
Serial COM Port: 1 (1 COM Port/ LMI System)

Recommended Computer Specifications:
Operating System: Windows 10 (64 Bit)
Screen Resolution: 1280x800
Memory: 8 GB
Processor Speed needed: Intel i7
Serial COM Port: 2 (2 COM Port/ LMI System)

Recommended User Requirements:
Administrative level access is necessary for installation.
Read/Write access to the default folders is necessary for

application use.

@ LMI Wireless Utility - Version 6.0.2.0 - = X
€3 Tools &b Info

ﬁ @ CJ égg 7 -

LME

Linear Measurement Instruments, Corp.  Software Version: - LMI Wireless Ltility - Version 6.0.2.0

Base Station Information

Serial Mumber: MC-USB-34000013EFDCDADT Description: MobileCollect USB Base
Model number: MC-USBB-00 Station 1D HDCDA
Firmware Version: 5.30 Network S/N: 3400001 3efdedall
Firmware Date: 3817 1450012 PAN ID: a213 Edt
Operational Mode:  Setup Base RF Channel: 21
Communication Protocal
COM Port Selection Parity Data Bits Stop Bits Handshaking
Selected COM: COM4 ® None 7 @ 1 (@ MNone
BaudRate Even (OF] 2 Hardware
Selected BaudRate: 0
Standard Wireless Base Global Output Format ( Includes: Reading)
Option 1: Wireless Base Global Output Format ( Includes: Reading, Gauge ID, Measurement Unit, Battery Life, Signal Strength)
Option 2: Wireless Base Global Output Format (Includes: Reading, Gauge 10)
Send >

Connection Status: COM Port Enabled: COM4 - 9600

*The exception to this is the LMI Diamondback Wireless Digital Indicator. As the Diamondback is configured via the button interface on the indicator, WU is used only for association to the USB base.
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4.2 Software Installation

1. Insert the LMI USB Wireless Utility Flashdrive into an open USB port on your computer. You will see the following folders and files:

» = WL 501708 (F:)

> ¥ Metwork

3 iterns

al [ B Drive Tools ~ WU_501708 (F:) - Ei X
Home Share View Manage 0
o+ J ¥ cut x L"_L"‘!'-_]New item - \ﬂ Open FH setect an
! - w-] Copy path —TJ Easy access = Edit Select none
Pin to Quick Copy Paste . love Copy Delete Rename Mew Properties ; :
access |#] Paste shortcut to ta - folder - History DDImtert selection
Clipboard Organize New Open Select
e v P am > WU_S0M708 (F) v @ P
Mame Type Size
3 Quick access
dotnetfx File folder
& OneDrive Wireless Base Driver File folder
I This PC @ CA 149 LMI Wireless Gauge Manual PDF File 1471 KB
i setup 4/6/2017 205PM  Application 421KB
ﬁl Wireless Install 476/2017 3:05 PM Windows Installer ... 4024 KB

Dotnetfx: This folder contains the required dotnet framework installer. Most modern PCs already have this installed, but if not, open the folder, double-click on

the icon, and follow the installation prompts to install the dotnet framework.

Wireless Base Driver: This folder contains the driver for the USB base that will transmit data to/from the wireless gauge(s). This must be installed before running
Wireless Utility.

LMI Wireless Gauge Manual: Copy of the Wireless Gauge Manual in .pdf format.

Setup/Wireless Install: Installation files for the LMI Wireless Utility. Double-click either icon to begin the installation process.
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2. After double-clicking either the Setup or Wireless Install icons, the Wireless Utility installation will begin. Follow the screen prompts.

15 LMI Wireless Utility — * 15 LMI Wireless Utility —

Welcome to the LMI Wireless Utility Setup Wizard License Agreement

Linear Measurement Instruments, Corp.

Flease take a moment to read the licenze agreement now. |f you accept the terms below, click 1
Agree", then "MNext". Othemwize chck "Cancel'’.

Wireless Utility End User License Agreement

PLEASE READ CAREFULLY: THE USE OF THIS SOFIWARE IS SUBJECT TO
THE SOFTWARE LICENSE TEBMS OF IMI Corporation, INC. RND CTHER
LICEHMS0ORS WHO'S SOFTWARE MAY BE BUNDLED WITH THIS FPRODUCT.BY
WARNING: Thi : s e di ) | : YOUR USE ©OF THE SOFTWARE INCLUDED WITH THIS PRODUCT YOU AGREE
it -:IIS CIED"“tF'”tE' F'C’IP%".E"";.W prcfut;;;le w copynght law tE'm ";t!fmat'ma "l'tafat'e*' o TO THE LICENSE TEGMS REQUIRED BY THE LICENSOR OF THAT SOFTWARE,
nauthorized duplication or distribution of this program, or any portion of it, may result in severe civi L R e e e S
or criminal penakies, and will be prosecuted to the masmum extent pozzible under the law,
APPLICABLE T{ THE SOFTWARE, ¥YOU MAY RETURN THE ENTIRE UNUSED .

(® | Do Mot Agree (1 Agree

Cancel < Back Cancel ¢ Back Mewxt »

Click on | Agree to accept the EULA and then press Next.

Click Next.
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Installation (cont.)

13 LM Wireless Utility - Pt 7 LMI Wireless Utility - X

LME L. ME

Select Installation Folder

Linear Measurement Instruments, Corp. Linear Measurement Instruments, Corp.
The inztaller will install LM *ireless Utility ta the following folder. The installer iz ready to install LM| ‘Wireless Utility on pour computer.
To install in thig folder, click "Mext". Toinstall to a different folder, enter it below or click ''Browse", Click "Mext'" to start the installation.
Folder:
C:\Program Files [86]\LM| Corparationh LM wireleszs tilitg', Browse. ..
Disk Cozt...

Cancel < Back Cancel < Back

Choose the folder location for the LMI Wireless Utility. LMI recommends Click Next.
the default folder shown above. Click Next.
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Installation (cont.)

15 LM Wireless Utility - X 75 LMI Wireless Utility - X
Installing LMI Wireless Ufility I ME Installation Complete I ME
Linear Measurement Instruments, Corp. Linear Measurement Instruments, Corp.
LI wirelezs Utility iz being installed. LM wirelezz Utility has been successfully installed.
Click "Cloge" to ewxit.
Please wait..
Pleaze usze Windows Update to check for any critical updates to the MET Framewark,
< Back est > Cancel < Back
Wait for the progress bar to fill. Click Close.
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4.3 Basic Operation of Wireless Utility

To start the LMI Wireless Utility, verify that you have the USB base (B LMi Wireless Utiliy - Version 6.0.2.0- -
plugged into a USB port on the PC, then double-click the Desktop icon 3 Tools € Info

or select the program name from the listed program files under the ﬁ @ o 00 = .

Start Menu. <7 2.0 |/ 52

LME

Linear Measurement Instruments, Corp.  Software Version: - LMI Wireless Utiity - Version 6.0.2.0

LMI Wireless

Uti“t.r.- Base Station Information
Serial Mumber: MC-USB-34000013EFDCDADT Description: MobileCollect USE Base
When detected, the Base Unit will populate the upper portion of the Model number: ~ MC-USBE-00 Station ID: 34DCDA
Ut|||ty window with the foIIowing: Firmware Version:  5.30 Network 5/M: 34000013 efdedall
Firmware Date: 3 817 14:5012 PAN 1D: a3 Edt -

¢ Serial number - The unique number assigned to the wireless Operational Mode:  Setup Base RF Channel: 21

base unit.
¢ Model Number - The unique number assigned to the wireless Gommncion brotocd

base unit COM Port Selection Parity Data Bits Stop Bits Handshaking

. ’ . . Selected COM: Ccom4 ® Mone 7 @1 ® None
¢ Firmware Version/Date - The current firmware and uploaded )
i i BaudRate Even ®s 2 Hardware

date of the wireless base unit. s
¢ Operational Mode - Current operation mode of the wireless Selacled BaudRals:

base unit.
¢ Description - The description name of the wireless base unit.
¢ Station ID - The unique wireless base unit station ID.
¢ Network S/N -The uniq ue wireless base unit network serial Standard Wireless Base Global Output Format ( Includes: Reading)

number. Option 1: Wireless Base Global Output Format ( Includes: Reading, Gauge 1D, Measurement Unit, Battery Life, Signal Strength)
¢ PANID-The unique V.VIFE|eS§ base unit PAN ID. . . Option 2: Wireless Base Global Output Format (Includes: Reading. Gauge 10}
¢ Base RF Channel - Unique wireless base unit RF communication Send >

channel.

o . . Connection Status: COM Port Enabled: COMA - 9600
The Communication Protocol and Output Format sections of the win- onnection Mot DN

dow are preconfigured to work with LMI’s UGI software. Do not make
changes to these sections without consulting LMI Technical Support at The status bar at the bottom of the window will turn green if the base is ready to receive data

(810) 569-1886 beforehand. from the LMI gauge(s).
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Top Menu Drop Downs

3 Tools & Info

¢ Connect Base (F2): Used to connect or reconnect a USB transceiver base. ¢ About: Displays currently installed version of Wireless Utility.

¢ Disconnect Base: Used to disconnect a USB transceiver base from the ¢ PCInformation: Pulls information about the PC on which Wireless Utility is installed.
software.

¢ Visit www.Imicorporation.com: Link to the LMI Corporation website.

¢ Masterfile Options: See Section 4.5 Masterfile Options.
P P ¢ Web Support: Hotlink to LMI’s online meeting room service

¢ COM Window: O Di tic Wind d by LMI Technical S t
indow: Opens Diagnostic Window (used by echnical stuppor ¢ WU Manual (F1): Opens the Wireless Utility manual .pdf.

to troubleshoot gauge issues).
¢ Software Agreement: End User License Agreement (EULA).

Icon Ribbon Bar

1. ﬁ@é 3@1. “15 E'

6. s 8.

1. Show Masterfile Options: (see Section 4.4).

2. Connection to the Wireless Base: On hover-over, will display the base ID if the base is connected.

3. Bluetooth Association button for LMI BTLE Gauges: Coming soon.

4. Reset the Wireless Utility software program: Used to restart Wireless Utility.

5. Data Collection Screen: Used to quickly see and collect readings from a gauge. Click the icon and then begin sending data. This data can be saved as a .txt file.
6. Remove Gauge Association: Used to remove association between a base and a gauge.

7. Add Gauge Association: Used to associate a base and a gauge.

8. Send Data to Excel: Allows the user to send readings to a new or existing Excel file. Customizable in the Masterfile to send both reading and gauge ID with header.
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4.4 Wireless Utility Masterfile Settings

To access the Wireless Utility Masterfile, either select Tools > Masterfile Options from the top menu bar or click on the gear icon in the Icon Ribbon Toolbar and enter the pass-
word admin when prompted.

@ Wireless Utility - MasterFile Options = *®
StatlUp GWHIZ Chats  Excel Setup  Support

Toolbar View Options Control Changes
Enable Menu Toolbar Enable Output Format
Enable Quick Toolbar Enable Change Channel

Enable De Association
Enable Quick Association
Enable Excel App

Enable Single Ertry Mode
[] Enable Live Stream Mode

Last Mastefile Update:  5/1/2018 4:02:00 PM Cancel Defaults Save...
Toolbar View Options Control Changes
Enable Menu Toolbar: Enables or disables dropdown menu for Tools. Enable Output Format: Enables the user to alter the base’s output to include only the

reading; the reading and the gauge ID; or the reading, gauge ID, measurement unit,
battery life, and signal strength from the opening window of UGI.

Enable Quick Toolbar: Turns respective icons on or off.

Enable De-association: Allows user to remove gauge association.
Enable Change Channel: Allows the user to change the RF channel on which the

Enable Quick Associations: Allows user to perform quick association. gauge is transmitting data.

Enable Excel App: Allows user to send readings directly to an Excel document.

Enable Single Entry Mode: Allows user to manually send readings from an LMI wire-
less gauge by pressing the button on the gauge.

Enable Live Stream Mode: Allows WU to monitor live activity from the gauge.
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@ Wireless Utility - MasterFile Options
StatUp GWHIZ Charts  Excel Setup  Support

GWHIZ Chart Download Options

AutoSave Chart Data
Enable GWHIZ Data Location:

Location: |C:'\.ngramData'-.LMI Corporation® WU Setup Files*.

Velocity Chart Download
[] Distance Chart Download
[ Acceleration Chart Download

Last Mastefile Update: ——-

GWHIZ Parameter Export Options

[] Enable GWHIZ Default Location:
Location: |C:\ProgramData‘LMI| Corporation® WLl Setup Files"

[] Append Date Time to File
[ Lock GWHIZ Gauge Parameters

Cancel Defaults

Save...

G-WHIZ Chart Download Options

AutoSave Chart Data allows WU to automatically save any graphed data from the G-WHIZ. The folder where this data is stored is setup under Enable G-WHIZ Data Location.

Velocity/Distance/Acceleration Chart Download allows the user to select which data set will be downloaded when using quick charts. NOTE: Acceleration cannot be down-

loaded with any other charts when using the Quick Chart function.

G-WHIZ Parameter Export Options

Enabling this allows the user to store the setup of a G-WHIZ in a specified folder as an .XML file for easy recall at a later date.
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Excel Setup

This screen allows the user to set up a header for the Excel
sheet when collecting data.

Enabling Include Header allows the user to add any of the
four options to the Excel document.

Wireless Reading Formatting allows the user to send ei-
ther all readings from a gauge or just the first or second
reading from a dual-output gauge such as a 241W or TP
Wireless. Also allows the user to either send or disable
sending the gauge ID with the reading.

Delimiter Formatting determines how the readings are
shown in Excel.

CR: Gauges will be input going down
Tab: Gauges will be input going across

Support Options

Enable Error Logging tracks actions taken within the utility
while in Setup Mode.

Enable COM Window allows the user to access a “terminal
interface” with the gauge so coding commands can be sent
to a gauge. This button also enables users to send data to
the COM window for quick verification of readings and
base setup.
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@ Wireless Utility - MasterFile Options
StatUp GWHIZ Charts  Excel Setup  Support

Excel Header Information
[ Include Header (Top of Page)

Wireless Reading Formatting
Include All Readings

Date [ Include First Reading

Time [ Include Second Reading

Reading [ Include Gauge ID on Each Reading
Gauge 1D

Last Mastefile Update: ———

Delimiter Formatting
CR Delimiter

[] Tab Delimiter

Cancel Defaults

Save...

@ Wireless Utility - MasterFile Options
StatUp GWHIZ Charts  Excel Setup  Support

Support Options

Enable Emor Logging
Enable COM Window

Last Mastefile Update: ———

Cancel Defaults

Save...




4.5 Gauge Association

After Wireless Utility finds the base unit connected to the PC, place the LMI wireless gauge in setup mode. On most models, setup mode on a gauge is indicated by a flashing
green LED on the gauge itself. All LMI gauges must be in setup mode before association can take place.

¢ To puta200W, 241W or 241W-BW, or True Position probe in setup mode, press and hold the button on the gauge until the LED begins to flash green. Release the button,
then press and release it again quickly to bring up the Wireless Gauge Information window.

¢ To put a Seal Gap or Dual Seal Gap gauge in setup mode, push and release the button. The green LED should begin flashing. Push and hold the button for about four sec-
onds until the unit beeps to bring up the Wireless Gauge Information window.

¢ To put a Diamondback Wireless Digital Indicator in setup mode, push and hold down the in/mm button for approximately four seconds. The words Setup Mode will briefly
appear on the LCD display followed by two alternately flashing triangles. Note: The Diamondback digital indicator has a separate manual for configuration. Please refer to
the manual for information and setup.

¢ To put a G-WHIZ in setup mode, push and hold the Center button until it stops flashing and push the down arrow button. Use the down arrow to select SETUP MODE from
the menu and push the center button. Press and release the center button again to bring up the Wireless Gauge Information window. (Note: The G-WHIZ has a separate
manual for configuration. Please refer to the CA183 G-WHIZ manual that shipped with the device for information on setup and configuration.

Once the gauge is in setup mode and the data has been sent to the software, a pop-up window will appear. Click on Okay to close the pop-up and then press the + icon from
the top icon bar. Another pop-up window will appear. Click okay to close the pop-up and press and release the button on the gauge again to populate the grid. Association is
now complete. For all gauges except for the Diamondback Wireless Digital Indicator, you can now configure the gauge parameters, calibrate, and/or re-zero the gauge by dou-

The Current Wireless Gauge is Associated with the Selected Base Unit. 200W Instructions
Gauge Model Gauge Label Gauge 1D Association Offset () | Span (xfy) | CAL LOW () | CA o
I 1 I 200 i L0147, YES 1] 10 0649

2 \
3 Double-click to enter the Edit Gauges screen
4
5
6
7
8
4 W
£ >

The Wireless Gage is Currently Connected.
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SECTION 5: Gauge Setup and Calibration using the Wireless Utility

5.1 LMI 200W Wireless Probe Transducer

Once the 200W has been placed in setup mode and associated with the
wireless base, double-click on the 1 within the first row of the grid to enter
the Edit Gauges screen for the 200W. Settings in the Probe Configurations
box at the top are global and will affect every measurement taken with the
probe.

¢ Gauge Model: Indicates type of gauge.

¢ Gauge Label: Label assigned to gauge.

¢ Gauge ID: Serial number assigned to gauge.

¢ Offset: Adds/subtracts a global value from the measured value.
¢ Span: Length of probe travel; DO NOT CHANGE.

¢ Time Out (min): Time gauge will remain in setup mode before shutting
off to save battery life.

¢ Units (mm/inches): Selects either inches or mm as unit of measure.
¢ Audio (On/Off): Turns on audio beep when in setup mode.
¢ Invert Sign (+/-): Reverses the polarity of the gauge.

To save any global changes, press the Update button.

Below the Probe Configurations box are three additional boxes:

¢ Probe Master: Used to calibrate the probe.

¢ Probe Feature: Used to quickly zero the gauge after the first calibration.
¢ Testing Window: Enables the user to view live readings from the probe.

A note on calibration vs. zeroing: The 200W retains its calibration values

internally, so once the initial three-step calibration process is performed, the

user only needs to re-zero periodically to keep the probe correctly calibrated. To do this, click on the Zero Master button, place the probe in the SM310 Master Block, and press

the Sample button.
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Gauge ID: L01472

LMI 200 Probe
Probe Configurations

Gauge Model: 200

Gauge 1D: LO1472
Offset: i) |
S

Time Out {min): in Minutes

Probe Master

() CAL LOW
() CAL HIGH
() CAL Master

Probe Feature
() Zero Master

Messages:

Units {mm.inches) Invert Sign (=)
Units mm/Inches): (@) set to (MM) Invert Sign (+/): @ (+) Sign
() Setto { Inches ) O (-) Sign
Audio (On/ Cff)
Audio (ONOFFE: () Audio (ON)
(®) Audio (OFF)
Update
Testing Window
SAMPLE




Calibrate the LO Position: Place the Gauge in LO position and press the Sample button
Wireless Probe: Fully extend the plunger

Probe Master

@ CAL LOW
() CAL HIGH
() CAL Master

SAMPLE

Calibrate the Hl Position: Place the Gauge in the HI position and press the Sample button.

Wireless Probe: Fully retract the plunger

Probe Master

() CAL LOW

—p
i® CAL HIGH
() CAL Master

Calibrate The Master Position: Place the Gauge in the Master position and press the Sample button.

Wireless Probe: Place into an SM310 Master Block

SAMPLE

Probe Master

() CALLOW

—
() CAL HIGH
(@) CAL Master

SAMPLE

Once calibration is complete, press the red X in the upper right-hand corner to save the calibration and close out the Edit Gauges window.
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5.2 LMI 241W Flush and Gap Gauge

Place the 241W in setup mode, and once associated with the wireless base, o]
double-click on the 1 within the first row of the grid to enter the Edit Gauges
screen. Settings in the Probe Configurations box at the top are global and

will affect ever measurement taken with the probe. CAE L o

¢ Gauge Model: Indicates type of gauge. LMI 241 Series Gauge
. Probe Configurations
* Gauge Label: La bel aSSlgned to gauge. o Units {mm/inches) Invert Sign Flush Asis (+/-)
Gauge Model: == Units {mm/Inches); Setto (MM | s L @
¢ Gauge ID: Serial number assigned togauge. | Ol oo ® + S.Ign
Gauge Label: () Setto {Inches ) (-] Sign
¢ Offset Flush/Gap: Adds/subtracts a global value from the measured Gauge ID: | p155s
value _ SN Invert Sign Gap Axis (+/+}
. ot Pl \:I Audio (ON/OFF): () Audio (ON) R e
¢ Span Flush/Gap: Length of probe travel; DO NOT CHANGE. ofsetGap 0 | ®© Audio (OFF) ® (-) Sign
! in): T il remain L C—
¢ Time Out (min): Time gauge will remain in setup mode before shutting i L Und
anGep e

off to save battery life.
Time Out {min}: 5 in Minutes

¢ Units (mm/inches): Selects either inches or mm as unit of measure.

. . . Flugh Probe Master Gap Probe Master Testing Window Gauge Battery Level
¢ Audio (On/Off): Turns on audio beep when in setup mode. O CALLOW Oyl i ——)
¢ Invert Sign Flush/Gap Axis (+/-): Reverses the polarity of the gauge. ) CAL HIGH () CAL HIGH O OO
) CAL Master () CAL Master Gap 75%

To save any global changes, press the Update button.

0.00

Flush/Gap Probe Featurs

Below the Probe Configurations box are three additional boxes: L SAMPLE
¢ Probe Master: Used to calibrate the probe.

¢ Probe Feature: Used to quickly zero the gauge after the first calibration.

¢ Testing Window: Enables the user to view live readings from the probe. Messages:

A note on mastering vs. zeroing: The 241W retains its calibration values, so

once the initial three-step mastering process is performed, the user only
needs to re-zero periodically to keep the probe correctly mastered. To do this, click the Zero Master button, place the 241W on the 720-D Master Block, and press the Sample
button.
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Calibrate the LO Position: Place the Gauge in LO position and press the Sample button

Fully extend the plunger

Fush Probe Master
(@) CAL LOW

() CAL HIGH
() CAL Master

Calibrate the Hl Position: Place the Gauge in the HI position and press the Sample button.

Fully retract the plunger

Fush Probe Master
(T CAL LOW

(® CAL HIGH
(") CAL Master

Calibrate The Master Position: Place the Gauge in the Master position and press the Sample button.

Place into an 761 Master Block

Fush Probe Master
() CAL LOW

() CAL HIGH
(®) CAL Master

Once calibration is complete, press the red X in the upper right-hand corner to save the calibration and close out the Edit Gauges window.

Gap Probe Master
(®) CAL LOW

() CAL HIGH

() CAL Master

Gap Probe Master
() CAL LOW

(®) CAL HIGH

i) CAL Master

Gap Probe Master
() CAL LOW

) CAL HIGH

(@) CAL Master

SAMPLE

SAMPLE

SAMPLE
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5.3 Wireless True Position Series (TP107W, TP108W)

Place the TP in setup mode, and once associated with the wireless base, =
double-click on the 1 within the first row of the grid to enter the Edit Gauges

screen. Settings in the Probe Configurations box at the top are global and Gauge ID: L00154
will affect ever measurement taken with the probe.
¢ Gauge Model: Indicates type of gauge. LMI TP Probes
Probe Configurations
¢ Gauge Label: Label assigned to gauge. it TP Units {mm/inches) Invert Sign A Axis {+/-}
auge Model: Units {mm /Inches): ® Setto (MM) nvert Sign (+ /O {+)Sign

¢ Gauge ID: Serial number assigned to gauge. Gauge Label: | () Setto {Inches ) (®) (-)Sign
¢ Offset Flush/Gap: Adds/subtracts a global value from the measured Gauge ID: 100154 Audio {On/ Off) Invert Sign B Ads (/)

value. Offsst A-Rxis: |0 | famka OHANS O Audio {ON) Invert Sign =/ - () (+)Sign

T Ol i © (s

¢ Time Out (min): Time gauge will remain in setup mode before shutting | spangadw ¢ L] Tum TP Calcudationss ON Update

off to save battery life. Time Ot rin. |2 | s Minutes

¢ Units (mm/inches): Selects either inches or mm as unit of measure.

¢ Span Flush/Gap: Length of probe travel; DO NOT CHANGE.

A-fxiz Probe Master B-Axis Probe Master Testing Window Probe Battery Level
¢ Audio (On/Off): Turns on audio beep when in setup mode. A-ods
() CAL LOwW O CALLOW 0 0 0 o T
¢ Invert Sign A/B Axis (+/-): Reverses the polarity of the gauge. () CAL HIGH () CAL HIGH .
B-Auis 75%
To save any global changes, press the Update button. 0 OO
A/B-Asis Frobe Feature i )
Caleulation
() Zero Master
Below the Probe Configurations box are three additional boxes: N/A SAMPLE
¢ A Axis/B Axis Probe Master: Used to calibrate the probe.
¢ A/B Axis Probe Feature: Used to quickly zero the gauge after the first
calibration.
Messages:

¢ Testing Window: Enables the user to view live readings from the probe.

A note on mastering vs. zeroing: The 241W retains its calibration values, so

once the initial three-step mastering process is performed, the user only needs to re-zero periodically to keep the probe correctly mastered. To do this, click on the Zero Master
button, insert the probe in the zero bushing sleeve and press the Sample button.
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Calibrate the LOW Position of the A-Axis: Place the probe in LO position and press the Sample button.

A-fxiz Probe Master

@ CAL LOW
() CAL HIGH

B-Auis Probe Master

() CAL LOW
() CAL HIGH

SAMPLE

Calibrate the HIGH Position of the A-Axis: Place the probe in the HI position and press the Sample button.

A-fxiz Probe Master

() CAL LOW
@) CAL HIGH

A-fxiz Probe Master

) CAL LOW
() CAL HIGH

A-fxiz Probe Master

) CAL LOW
() CAL HIGH

AsB-Auis Probe Feature
(@) Zero Master

B-Auxiz Probe Master

() CAL LOW
() CAL HIGH

B-Auxis Probe Master

(®) CALLOW
() CAL HIGH

B-Auis Probe Master

() CAL LOW
(@) CAL HIGH

SAMPLE

If calibration is accepted,
click on the CAL LOW of
the B-Axis Probe Master

window.

SAMPLE

SAMPLE

If calibration is accepted,
click on the Zero Master
window and insert the
probe into the Zero
Bushing sleeve.

SAMPLE

Press the red X in the
upper right-hand corner
to save the calibration
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5.4 Wireless SealGap Series (237W, 238W, 237W Ultra-Mini)

Place the SealGap gauge in setup mode and once associated with the wire-
less base, double-click on the 1 within the first row of the grid to enter the
Edit Gauges screen. Settings in the Probe Configurations box at the top are
global and will affect ever measurement taken with the probe.

¢ Gauge Model: Indicates type of gauge.
¢ Gauge Label: Label assigned to gauge.
¢ Gauge ID: Serial number assigned to gauge.

¢ Offset Flush/Gap: Adds/subtracts a global value from the measured
value.

¢ Span Flush/Gap: Length of probe travel; DO NOT CHANGE.

¢ Time Out (min): Time gauge will remain in setup mode before shutting
off to save battery life.

¢ Units (mm/inches): Selects either inches or mm as unit of measure.
¢ Audio (On/Off): Turns on audio beep when in setup mode.
¢ Invert Sign Flush/Gap Axis (+/-): Reverses the polarity of the gauge.

To save any global changes, press the Update button.

Below the Probe Configurations box are three additional boxes:

¢ Probe Master: Used to calibrate the probe.

¢ Probe Feature: Used to quickly zero the gauge after the first calibration.

¢ Testing Window: Enables the user to view live readings from the probe.

A note on zeroing vs. zeroing: The 241W retains its calibration values, so

once the initial three-step mastering process is performed, the user only
needs to re-zero periodically to keep the probe correctly mastered.

LMI Wireless Utility Manual 32

(-]

Gauge ID: L02723

LMI SealGap Gauge
Gauge Configurations

Gauge Model; 55

Gauge Label:

Gauge 1D: L0273

oret
Time Out )

Gauge Master

() CAL LOW
() CALHIGH
() CAL Master

Gauge Feature
() Zero Master

Messages:

Units {mm/inches) Inwvert Sign (=)
Units {mm/inches): @) etto (MM) nvert Sign (+/J: @ (+) Sign
() Setto { Inches ) O (-)Sign
Audio (On/ Off)
Audio (ONOFF): (70 pudio (ON)
(® Audio {OFF)
e e Enable Push Button Reverse Update
Testing Window Gauge Battery Level
|1 1 |
100%
SAMPLE




Calibrate the LO Position: Place the Gauge in LO position and press the Sample button

Gauge Master

(®) caLLow
() CAL Master

SAMPLE

237W Ultramini

Calibrate the HI Position: Place the Gauge in the High position and press the Sample button.

Gauge Master

() CAL LOW
(®) CAL HIGH
(") CAL Master

SAMPLE

Gauge Master

() CAL LOW
() CAL HIGH
(@) CAL Master

SAMPLE

Once calibration is complete, press the red X in the upper right-hand corner to save the calibration and close out the Edit Gauges window.
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5.4 Wireless Dual SealGap Series

Place the TP in setup mode and once associated with the wireless base, dou-

ble-click on the 1 within the first row of the grid to enter the Edit Gauges

screen. Settings in the Probe Configurations box at the top are global and will

affect ever measurement taken with the probe.

*

*

L2

L2

Gauge Model: Indicates type of gauge.
Gauge Label: Label assigned to gauge.
Gauge ID: Serial number assigned to gauge.

Offset Flush/Gap: Adds/subtracts a global value from the measured
value.

Span Flush/Gap: Length of probe travel; DO NOT CHANGE.

Time Out (min): Time gauge will remain in setup mode before shutting
off to save battery life.

Units (mm/inches): Selects either inches or mm as unit of measure.
Audio (On/Off): Turns on audio beep when in setup mode.

Invert Sign Flush/Gap Axis (+/-): Reverses the polarity of the gauge.

To save any global changes, press the Update button.

Below the Probe Configurations box are three additional boxes:

*

*

*

Probe Master: Used to calibrate the probe.
Probe Feature: Used to quickly zero the gauge after the first calibration.

Testing Window: Enables the user to view live readings from the probe.

A note on mastering vs. zeroing: The Dual SealGap gauge retains its calibra-

tion values, so once the initial three-step mastering process is performed,

@ LMI Wireless Utility - Edit Gauges

Gauge ID: L02292

LMI Dual SealGap Gauge
Gauge Configurations

z Units {mm.inches) Inwert Sign (=)
G Model: Cual5G : :
auge Mo Units {mm/Inches): @® Setto (MM) nvet Sign (+ /. ® (+)Sign
Gauge Label: () Setto {Inches ) O (-} Sign
Gauge 1D: L0252
Audio (On/ Off) Invert Sign B-Axis (/)

Offset -A: Audio {ON/OFF): () Audio (ON) Invert Sign (+): @ (+) Sign
Offset -B: 1282 (®) Audio [OFF) O {-) Sign
Time Out {min): in Minutes Enable Push Button Reverse Update

Gauge Master Gauge Master Testing Window Gauge Battery Level

Reading A

) CAL LOW () CALLO _I 2 96 L -

) CAL HIGH () CALHI .

(O CAL Master (O CAL Master Reading B 100%

Gauge Feature
() Zero Master

Messages:

8.99

SAMPLE

the user only needs to re-zero periodically to keep the probe correctly mastered.
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Calibrate the LO Position: Place the Gauge in LO position (fully retracted) and press the Sample button

Gauge Master Gauge Master
(® CALLOW (@ CALLO
SAMPLE
() CAL HIGH () CALHI
O CAL Master O CAL Master
Calibrate the Hl Position: Place the Gauge in the HI position (fully extended) and press the Sample button.
Gauge Master Gauge Master
) CALLOW () CALLO
SAMPLE
(®) CAL HIGH (@) CALHI
O CAL Master O CAL Master
Calibrate The Master Position: Place the Gauge in the Master position and press the Sample button.
Gauge Master Gauge Master
() CAL LOW () CALLO
SAMPLE
() CAL HIGH (0 CALHI
(®) CAL Master (®) CAL Master

Once calibration is complete, press the red X in the upper right-hand corner to save the calibration and close out the Edit Gauges window.
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SECTION 6: Advanced Wireless Utility Features

6.1 Using the Data Collection Screen

e To enter the Data Collection Screen, open the Wireless Utility and click on the Data Capture icon: J

e  Press the button on the gauge to send readings to the screen.

e Once datais sent to the screen, press the Print button to send the information to a printer or click on File > Save to save the data as a .txt file.
e Toclear the screen, click on Refresh Screen or click on the refresh button in the lower right hand corner of the window.

e Under File, there is also the option to increase the font size of the readings on the screen from 12 to 18 or 20.

e To exit the screen, click on the X in the upper right hand corner of the window.

-]

" File @ Refresh Screen ™~ Print

00,L01472
00,L01472
00,L01472
00,L01472
1.38,L01472
1.38,L01472
226101472
00,L01472
00,L01472
00,L01472
Start of Data Capture - 5/7/2018 2:26:10 PM

Collection Paints: 11

Data Received - 5/7/2018 2:26:36 PM Single Data Entry Mode Activated.
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6.2 Sending Measurements to Excel

NOTE: An authorized copy of Excel must be installed on the PC running Wireless Utility in order for this feature to work properly.

To setup the data that will be sent to the Excel sheet, click on Tools > Masterfile Options, then click on the Excel Setup tab. See page 24 for explanation of each setting.

e Tosend data to Excel, open Wireless Utility and click on the Excel Spreadsheet button: | 5z~

e Click on New to send the data to a blank Excel sheet or Open to select an existing Excel sheet.

e Once the Excel sheet opens, press the button on the probe to send the reading (and any other attached data to the reading) to the sheet.

e Below is an example of 10 readings sent to an Excel spreadsheet with the date, time, reading, and gauge ID set up as a header (Include Gauge ID on Each Reading is

checked):

Y=

|2

T R 8 ]

=] h un

A E C D
5/7/2018 4:06:14 PNk Reading 1 Gauge ID

10 L01472
9.99 101472
9.49 01472
8.94 01472
7.93 101472
7.48 101472

6.2 01472

5.4/L01472
4.38 101472
4.04 101472
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